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Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be 
construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, 
Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notice
© Copyright 1994-2014 Hewlett-Packard Development Company, L.P.

Trademark Notices
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written by Tim Hudson (tjh@cryptsoft.com). Smack 
software copyright © Jive Software, 1998-2004. SVG Viewer, Mozilla JavaScript-C (SpiderMonkey), and Rhino software Copyright © 1998-2004 The Mozilla Organization. 
This product includes software developed by the OpenSSL Project for use in the OpenSSL toolkit. (http:// www.openssl.org). OpenSSL software copyright 1998-2005 The 
OpenSSL Project. All rights reserved. This project includes software developed by the MX4J project (http://mx4j.sourceforge.net). MX4J software copyright © 2001-2004 MX4J 
Team. All rights reserved. JFreeChart software © 2000-2004, Object Refinery Limited. All rights reserved. JDOM software copyright © 2000 Brett McLaughlin, Jason Hunter. 
All rights reserved. LDAP, OpenLDAP, and the Netscape Directory SDK Copyright © 1995-2004 Sun Microsystems, Inc. Japanese Morphological Analyzer © 2004 Basis 
Technology Corp. The Sentry Spelling-Checker Engine Copyright © 2000 Wintertree Software Inc. Spell Checker copyright © 1995-2004 Wintertree Software Inc. CoolMenu 
software copyright © 2001 Thomas Brattli. All rights reserved. Coroutine Software for Java owned by Neva Object Technology, Inc. and is protected by US and international 
copyright law. Crystal Reports Pro and Crystal RTE software © 2001 Crystal Decisions, Inc., All rights reserved. Eclipse software © Copyright 2000, 2004 IBM Corporation 
and others. All rights reserved. Copyright 2001-2004 Kiran Kaja and Robert A. van Engelen, Genivia Inc. All rights reserved. Xtree copyright 2004 Emil A. Eklund. This product 
includes software developed by the Indiana University Extreme! Lab (<http:// www.extreme.indiana.edu/>). Portions copyright © Daniel G. Hyans, 1998. cbg.editor Eclipse 
plugin copyright © 2002, Chris Grindstaff. Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are copyright © 2001-2004 Robert A. 
van Engelen, Genivia Inc. All Rights Reserved. Copyright © 1991-2005 Unicode, Inc. All rights reserved. Distributed under the Terms of Use in http:// www.unicode.org/ 
copyright.html.

Adobe™ is a trademark of Adobe Systems Incorporated.

Java™ is a registered trademark of Oracle and/or its affiliates.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

UNIX® is a registered trademark of The Open Group.

For a complete list of open source and third party acknowledgements, visit the HP Software Support Online web site and search for the product manual called HP Service 
Manager Open Source and Third Party License Agreements.

Documentation Updates
The title page of this document contains the following identifying information:

 l Software Version number, which indicates the software version.
 l Document Release Date, which changes each time the document is updated.
 l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to:           http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:           http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.

Support
Visit the HP Software Support Online web site at: http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support that HP Software offers.
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HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage your 
business. As a valued support customer, you can benefit by using the support web site to:

 l Search for knowledge documents of interest
 l Submit and track support cases and enhancement requests
 l Download software patches
 l Manage support contracts
 l Look up HP support contacts
 l Review information about available services
 l Enter into discussions with other software customers
 l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to: 

      http://h20230.www2.hp.com/new_access_levels.jsp

HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables you to explore HP Product Solutions to meet your business 
needs, includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this Web site is 
http://h20230.www2.hp.com/sc/solutions/index.jsp
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This document is an overview of the changes made to HP Service Manager 9.21 for patch 9. It contains 
important information that is not included in other documentation. 
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What's New in This Release
This section describes important changes in this release.

Important:              Based on customer feedback, the overall quality of Service Manager has been an area 
of concern over the last number of years. To that end, the Service Manager R&D team has spent a 
significant amount of effort improving the quality of Service Manager, and recent customer 
feedback is very positive. Many defects that have been in the product for many years are now 
fixed in the SM 9.3x. The issues resolved in this build patch cover only the most critical fixes.  To 
gain better performance and user experience, we strongly recommend that you apply the latest 
binaries from SM 9.3x instead of this build patch.

    In most cases SM 9.3x binaries are compatible with SM 7.1x and SM 9.2x applications. 
Therefore,  you are not required to perform a full upgrade to take advantage of the latest Service 
Manager technology.  Specific compatibility details are listed in the SM 9.3x release notes.         

Certifications
This release includes the following support matrix changes.

Added support

 l Windows 2008 and Windows 2008 R2 (for the K2 Search Engine server)

Discontinued support

 l Windows XP

See also the compatibility matrix for Service Manager 9.21 on the Software Support Online (SSO) site: 
http://support.openview.hp.com/sc/support_matricies.jsp
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Enhancements
This release includes the following enhancement.

CR Module Problem Solution

QCCR1E113188 Server Support of Windows 2008 is 
needed for the K2 search 
engine.

Windows 2008 and Windows 2008 R2 
are now supported for the K2 search 
engine. 
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Fixed Defects
This release fixes the following defects.

Server
CR Problem Solution

QCCR1E76968 When Service Manager web 
service integrations are at the rate 
of 10K per hour, the following 
message occurs:

Web service negative start 
attribute, start from first 
record

If the start attribute has no value in the 
SOAP request, the "Web service

negative start attribute, start from first 
record" message no longer exists.

QCCR1E99897 When you try to add a new scacess 
record after you upgrade the 
Service Manager RTE, an error 
occurs during the login process.

The error does not occur when you add 
a new scaccess record.

QCCR1E103106 When you apply customize 
applications patch, it fails with a 
"Signal 11" error.

The "Signal 11" error is caused by a 
NULL pointer. Service Manager now 
checks the pointer whether it is NULL 
before using it. Therefore, the process 
does not fail and no "Signal 11" error 
occurs.

Windows Client
CR Problem Solution

QCCR1E104455 When you save an unload record in 
the Windows client, the following 
error occurs:

<_arrayCompare: entry 1: 
invalid argument 
(us.sort.as,start)> 

When you save an unload record in 
the Windows client, it is saved 
without any error.
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Known Problems, Limitations, and Workarounds
The following table lists the known issues discovered in this release.

Global ID Known Issue Workaround

QCCR1E89890 Grouped Views are not correctly updated 
after logging a new incident.

When you log a new incident, to 
keep consistency with actual 
incidents, the group number is not 
updated. 

You need to click the Refresh button 
to update grouped Views.

QCCR1E72809 After closing a ticket (such as an 
Interaction or Incident) and returning to the 
view, the queue is not synchronized 
correctly.

As a workaround, click the Refresh 
button to solve the view display 
issue.
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Documentation Errata
The following documentation item is incorrect. 

Location:

Online help: Help topic "Startup parameter: agstackl"

Error: :    

The default value of this parameter is 400.

Correction:

The default value of this parameter is 600.
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Backout Instructions
If you want to restore your Service Manager system to its original state after installing this patch, follow 
these guidelines.

Server
To backout your server changes, make a backup before installing the patch and then roll back.

Backup

Before applying the server patch, make a backup of the server installation folder. For example, 
C:\Program Files\HP\Service Manager 9.21\Server.

Note: If you have a load balanced system, be sure to back up the server installation folder for 
every server instance respectively.

Backout

To restore your Service Manager server to its original state after installing the patch, do the following:

 1. Stop the Service Manager server.

 2. Remove the existing server installation folder.

 3. Copy the backup folder back.

Note: Make sure that the embedded Tomcat is also replaced with the backup as the version 
of the embedded Tomcat may have dependency with specific server version.

 4. Restart the Service Manager server.

Note: If you have a load balanced system, make sure that every server instance is replaced with 
its respective backup.

Web Tier
Backup

Before deploying the new web tier, make a backup of the following items:
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 l web.xml file

 l application-context.xml

 l splash screen

 l style sheets

 l any other customizations you made, including your webtier-9.21.war (webtier-ear-9.21.ear) file.

Backout

To roll back to the old web tier:

 1. Delete or uninstall the existing web tier.

 2. Clear the cache of your web application server (for example, Tomcat).

 3. Redeploy the old web tier.

 4. Restore your old customizations.

Windows Client
To roll back to your old Windows client, you need to do backup before installing the new Windows client 
and then reinstall the previous Windows client.

Backup

 1. Make a backup of your Windows client home folder, for example, 
C:\Users\<username>\ServiceManager. Your connections and personalized settings are stored 
in this folder.

 2. Make a backup of your security configuration files if any (Window > Preferences > HP Service 
Manager > Security). For example, your CA certificates file and client keystore file.

Backout

 1. Uninstall the new Windows client.

 2. Reinstall the previous Windows client.

 3. Restore your old Windows connections and configurations.

Applications
Backup
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Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are recommended 
to use Unload Manager to make a backup of the files to be modified by an unload file, because 
Unload Manager can create a backup of your old data during the installation of the unload; if your 
application version is other than any of these, Unload Manager is not available and you can use 
Database Manager instead. 

To use Unload Manager to make a backup:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next.

Details of the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To use Database Manager to make a backup:

 1. Go to Database Manager, select Import/Load from More or the More Actions menu, and browse 
to the unload file.

 2. Click List Contents on the menu bar, to view a list of files that have been updated in this unload.

See the following figure for an example.
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This figure shows the contents of an unload file that contains changes to the following files:

File Record

Process     svc.add.cart

application money.format

Note: The scmessage records listed under each RAD application are 
messages used in this RAD application; no backup is needed for them.

ScriptLibrary svcCartHelper

datadict activity

dbdict activity

Note: The “activity” file with no records actually represents the dbdict record 
of the activity file.

scmessage The record whose message class is “fc” and message number is 1000. 

 3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the 
Search button.

 4. If the format selection page shows, select the proper format by double-clicking it (for example, 
select the device format for the device file), and then search for the file record.
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 5. Click More (or the More Actions menu) > Export/Unload after the file record displays.

Note: If Export/Unload is not available, check the Administration Mode check box in 
Database Manager and try again.

 6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl. 

Caution: Make sure that Append to file is selected.

 7. Repeat steps 3 through 6 to back up the rest of the files you got in step 2.

Backout

Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is not 
available in your application version) to roll back to your old data, as described in the following.

To roll back to your old data using Unload Manager:

 1. Go to  System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload.

A wizard opens.

 3. Select the unload file generated in the backup process, specify a backup file, and then click Next.

Details of the unload file display.

 4. Double-click a conflicting object in the table to open the merge tool:
 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to return to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the backup unload.

 7. Click Finish.

To roll back to your old data using Database Manager:

 1. Go to Database Manager, click More > Import/Load.

 2. Browse to the backup unload file you created.

 3. Click Load FG.
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Installation Notes
This section provides instructions on installing each component in this patch release.

Digital Signature Notice
HP signs Windows executable files with a digital signature. Since January 2012, this process has been 
updated to use a new VeriSign root certificate. On a Windows system that does not have the new 
VeriSign root or intermediate certificate installed, when the user right-clicks the file and then goes to 
Properties > Digital Signatures > Details, a verification error will display: “The certificate in this 
signature cannot be verified.”

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate as 
documented at: https://knowledge.verisign.com/support/ssl-certificates-
support/index?page=content&actp=CROSSLINK&id=SO19140
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Web Tier Installation
This release does not contain any updates to the Web Tier. The latest Web Tier was released together 
with the Service Manager 9.21p8 release. You can download the latest Web Tier shipped with the 
Service Manager 9.21p8 release:

https://softwaresupport.hp.com/group/softwaresupport/search-result/-
/facetsearch/document/KM00685823

Windows Client Installation
The Windows client update consists of a compressed file, sm9.21.706-P9_Windows_Client.zip, which 
contains the executable installation files.

To install the Windows client update:

 1. Stop the Service Manager Windows client.

 2. Make necessary backups. For details, see "Backout Instructions" on page 11.

 3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are 
retained.)

 4. Run setup.exe and install the client by following the instructions in the Service Manager 
Installation Guide.

 5. Check the version in Help > About Service Manager Client.

The client should be Release: 9.21.706.

Windows Client Configuration Utility Installation
This release does not contain any updates to the Windows Client Configuration Utility. You can 
download the latest Windows Client Configuration Utility shipped with the Service Manager 9.21p8 
release:

https://softwaresupport.hp.com/group/softwaresupport/search-result/-
/facetsearch/document/KM00685831

For detailed installation instructions, see the Service Manager 9.20 Installation Guide, which is 
available from the HP Software Manuals Site: 

http://support.openview.hp.com/selfsolve/document/KM912628
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Server Update Installation
The server update for your operating system (OS) consists of a compressed file, sm9.21.706-P9_
<OS>.zip (or .tar), which contains the Service Manager server files. These files add to or replace the 
files in the [SM Server Root]\ ([SM Server Root]/) RUN, irlang, legacyintegration, and 
platform_unloads directories.

Note: If you have a load balanced system, you must upgrade all server instances.

Caution: This server update will upgrade the embedded Tomcat to version 6.0.36, and therefore 
requires additional steps.

Note: The SM9.21p8 server requires JRE 1.7 (except for Solaris 9).  For Windows and Linux,  the 
embedded JRE has already upgraded to version 1.7; for other Unix-based platforms, you need to 
manually perform this JRE upgrade.

The JRE upgrade will cause external web service calls over SSL to fail if the remote endpoint does 
not support Server Name Indication (SNI), which is by default activated in JRE 1.7. Once Service 
Manager is upgraded to use JRE 1.7, it starts to use SNI extensions during the SSL handshake. If 
the remote endpoint does not support SNI, the web service call will fail with an error message. To 
solve this issue, do either of the following: 

 l Activate SNI at the remote end point (recommended)

 l If the remote endpoint does not support SNI extensions, and SNI cannot be activated, add the 
following JVMOption<n> parameter either to the sm.ini file, or to the start command of the 
servlet(s) in the sm.cfg file:

JVMOption2:-Djsse.enableSNIExtension=false

To install the Server update:

 1. Stop all Service Manager clients.

 2. Stop the Service Manager server.

 3. Make a backup of the Server installation directory. See also "Backout Instructions" on page 11.

 4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.36 when 
you extract the server files later.

 5. Delete the RUN/lib directory.

 6. For Windows and Linux platforms, delete the RUN/jre directory. 
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Note: This step is required only when you are upgrading from a server version earlier than 
9.21p7. This is to avoid conflicts between the old 1.6-based JRE and new 1.7-based JRE.

 7. Extract the compressed files for your operating system into the main Service Manager directory on 
the server. The default path is: C:\Program Files\HP\Service Manager 9.21\Server.

 8. For UNIX servers, set the file permissions for all Service Manager files to 755.

 9. For UNIX servers other than Solaris 9, manually upgrade to JRE1.7.

Note: Solaris 9 does not support JRE7. You can run the SM server on Solaris 9 with only JRE 
1.6.0_20 or later.

 a. Install either JDK1.7 or JRE1.7 for your specific platform.

Solaris 10 JRE1.7 (update 15  or greater)

HP-UX JRE1.7 (JRE_7.0.04 or greater)

AIX JRE1.7 (SR4 or greater)

 b. Set your JAVA_HOME environment variable to point to JDK1.7 (if you have JDK1.7 installed) 
or JRE1.7 (if you have only JRE1.7 installed).

 c. Execute \RUN\removeLinks.sh to remove the old symbolic links and then execute 
\RUN\setupLinks.sh to create new symbolic links. 

 d. Run the following command to check that the JRE version is 1.7: 

RUN\jre\bin\java –version

 10. If you have made any customizations/changes to the original RUN/tomcat folder, restore them in 
the new RUN/tomcat folder.

 11. Make sure the server is stopped, and run the sm -unlockdatabase command.

Note: The purpose of this step is to prevent stale license information from being kept in the 
system. In a scaling implementation, you can run this command from any one of your servers.

Caution: This step is required the first time you upgrade to 9.21p6 or later; it is also required 
whenever you change the server’s IP address after your upgrade to 9.21p6 or later.

 12. Restart the Service Manager server.
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 13. Restart the Service Manager clients.

 14. Check the version in Help > About Service Manager Server. The server should be Release: 
9.21.706.

Application Unload Installation
If a platform fix (in most cases, a server fix) also requires an applications change to resolve the relevant 
issue, an unload file is provided. Unload files introduced in earlier patches are also included in this 
cumulative release. If you have not already applied them for a previous patch, you should also apply the 
unload files that are intended for your applications version. For more details about these applications 
updates, see the Release Notes for those patches.

This patch release includes the unload files that come with the server update. When you extract 
sm9.21.706-P9_<OS>.zip (or .tar), it will add the files to the following directory:

[SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads)

Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 
should be applied first, then those introduced in patch 2, and so on. However, unload files 
introduced in the same patch can be installed in a random order, unless otherwise specified.

Unload File Naming Convention
The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:

 l <CR_ID>: The identification number of the applications defect that the unload file fixes. For 
example, QCCR1E12345. Note that this is always the number of the parent CR of a CR family (if 
any).

 l SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example, 
SM921P2, which means the unload file comes with the server updates in Service Manager 9.21 
patch 2 and should be used for patch 2 or higher.

Note: Sometimes this portion contains an additional hot fix number, for example, 
SM711P16HF8. This example means the unload file is intended for Service Manager 7.11 
patch 16 Hot Fix 8 or higher.

 l SMxxx: The Service Manager applications version that requires the unload file. For example, 
SM711, which means the unload file is intended only for Service Manager applications version 7.11.

Note: If the applications version suffix is omitted, the unload file is then intended for all 
applications versions compatible with the server version, unless otherwise specified. For 

Patch 9 Release Notes
Installation Notes

HP Service Manager (9.21) Page 20 of 28



example, for Service Manager server 9.21, the compatible applications versions are 7.11 and 
9.20.

Application Updates in Previous Patches
The following table lists the unload files introduced in previous patch release.

Unload file

Introduced 
in 9.21 
patch

Used for 
applications 
version(s) Description

QCCR1E29881_
SM921P1.unl

P1 7.11 and 
9.20

Includes application changes to reduce database 
I/O on login.

QCCR1E57766_
SM921P1.unl

P1 7.11 and 
9.20

Includes application changes to reduce jgroups 
traffic on login.

QCCR1E59753_
SM921P2.unl

P2 7.11 and 
9.20

Includes application changes to fix the ToDo bar.

QCCR1E31545_
SM921P2_
SM711.unl

P2 7.11 Prevents backslashes included in a template from 
being duplicated in the output.

Note: This file is not required for Applications 
7.00.

QCCR1E31545_
SM921P2_
SM920.unl

P2 9.20 Prevents backslashes included in a template from 
being duplicated in the output.

QCCR1E48580_
SM921P3_
SM711.unl

P3 7.11 Enables translation of Display/Value lists on 
dynamic forms. This is a required fix for the Export 
to Excel redesign.

QCCR1E48580_
SM921P3_
SM920.unl

P3 9.20 Enables translation of Display/Value lists on 
dynamic forms. This is a required fix for the Export 
to Excel redesign.

QCCR1E48513_
SM921P3_
SM711.unl

P3 7.11 Lists the records in the right group order when a 
record list is refreshed.

QCCR1E58562_
SM921P3_
SM711.unl

P3 7.11 Includes applications changes for Export to Excel 
redesign.
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Unload file

Introduced 
in 9.21 
patch

Used for 
applications 
version(s) Description

QCCR1E58562_
SM921P3_
SM920.unl

P3 9.20 Includes applications changes for Export to Excel 
redesign.

QCCR1E67610_
SM921P4.unl

P4 7.11 and 
9.20

Enables you to block potentially dangerous 
attachments.

QCCR1E67072_
SM921P4.unl

P4 7.11 and 
9.20

Enables you to improve the Knowledge 
Management update process (KMUpdate) 
performance.

QCCR1E67647_
SM921P5.unl

P5 7.11 and 
9.20

Updated the scmessage record from "Doc Engine 
call failed” to include the message number.

QCCR1E70163_
SM921P5_
SM711.unl

P5 7.11 Prevents the KMUpdate process from terminating 
when the Search Engine server is shut down or an 
indexing document error occurs.

QCCR1E70163_
SM921P5_
SM920.unl

P5 9.20 Prevents the KMUpdate process from terminating 
when the Search Engine server is shut down or an 
indexing document error occurs.

QCCR1E71099_
SM921P6_
SM711.unl

P6 7.11 Enables the Value Lists to be displayed instead of 
the data directly retrieved from the database in a 
QBE list when adding a field by using Modify 
Columns.  

QCCR1E71099_
SM921P6_
SM920.unl

P6 9.20 Enables the Value Lists to be displayed instead of 
the data directly retrieved from the database in a 
QBE list when adding a field by using Modify 
Columns. 

Applying Unload Files

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are recommended 
to use Unload Manager to load an unload file, because Unload Manager can help you create a 
backup of your old data and reconcile conflicts during the installation of the unload; if your 
application version is other than any of these, Unload Manager is not available and you can use 
Database Manager instead. 

To load an unload file using Unload Manager:

Patch 9 Release Notes
Installation Notes

HP Service Manager (9.21) Page 22 of 28



 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details of 
the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To load an unload file using Database Manager:

 1. Make sure the Windows client is configured for server-side load/unload.

 a. From the Windows client, go to Window > Preferences > HP Service Manager.

 b. Unselect Client Side Load/Unload if is flagged.

 c. Restart the Windows client.

 2. Open Tailoring > Database Manager.

 3. Right-click the form or open the More Actions menu and select Import/Load.

 4. Browse to the unload file, and view the contents of an unload file before importing it by clicking 
List Contents.

 5. Make a backup copy of all files to be modified by this unload. For detailed steps, see "Backout 
Instructions" on page 11.
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 6. Fill in the following fields.

Field Description

File Name Type the name and path of the file to 
load.

Import Descriptor Since unload files do not require an 
Import Descriptor record, leave this field 
blank.

File Type Select the source operating system of 
the unload file.

Messages Option —
All Messages

Select this option to see all messages 
that Service Manager generates loading 
the file.

Messages Option — 
Totals Only

Select this option to see only the total 
number of files Service Manager loads.

Messages Option — 
None

Select this option to hide all messages 
that Service Manager generates when 
loading the file.

 7. Click Load FG.

ODBC Driver Update Installation

Note: This release does not contain any ODBC Driver update. The latest ODBC Driver patch has 
been shipped with the SM9.21p6 release, which you can download from 
http://support.openview.hp.com/selfsolve/document/KM00234051

The ODBC Driver update contains the following updated files:

 l Scodbc32.dll

 l sci18n.dll

 l sccl32.dll

To install the ODBC Driver update:

 1. Extract the files to your ODBC Driver installation folder, for example: C:\Program 
Files\Peregrine Systems\ServiceCenter 6.2\ODBC Driver.

 2. When prompted, replace the three old DLL files with the new ones.
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Knowledge Management Import Utility Update 
Installation

Note: This release does not contain any Knowledge Management update. The latest Knowledge 
Management Import Utility patch has been shipped with the SM9.21p7 release, which you can 
download from: 

http://support.openview.hp.com/selfsolve/document/KM00438944

To install the knowledge Management Import Utility Update:

 1. Extract km-import-9.21.zip in the Knowledge Management package (sm9.21.624-P7_
KM.zip) to a local drive.

 2. For detailed instructions on the use of the import utility, see the README file packaged in the km-
import-9.21.zip file.
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Service Manager Verified Environments
The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software 
products, and other compatibility and support information.

Note: Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require an active support contract. To find more information about support access levels, go to      
Access levels.

To register for an HP Passport ID, go to      HP Passport Registration.

To access the Compatibility Matrix:

 1. Use a browser to navigate to the Software Support Online (SSO) web page:

http://support.openview.hp.com/sc/support_matrices.jsp

 2. Log on with your Customer ID and password or your HP Passport sign-in.

 3. Navigate to the applicable information.
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Local Language Support
UTF-8 is part of the Unicode standard, which enables you to encode text in practically any script and 
language. Service Manager 9.21 supports UTF-8 as an encoding method for new or existing data. It can 
support multiple languages that adhere to the Unicode standard on the same server.

Service Manager 9.21 or later does not provide language packs. A language pack of Service Manager 
9.20 is available for each of the following languages: Japanese, French, Italian, German, Spanish, 
Korean, Russian, Brazilian Portuguese (UI only), Dutch (UI only), Polish (UI only), Czech (UI only), 
Hungarian (UI only), and Simplified Chinese.

Service Manager 9.21 or later can only work with Service Request Catalog (SRC) 1.20, which is 
English only.
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